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All pressure equipment with an internal pressure greater than 0.5 bar (g) and a size larger than 25mm or 1" (inch) falls under the Pressure Equipment Directive (PED). 

Å The Specifications Section of this manual contains instructions related to the PED directive. 

Å Products described in this manual are in compliance with EN directive 2014/34/EU. 

Å All Brooks Instrument Flowmeters fall under fluid group 1. 

Å Products larger than 25mm or 1" (inch) are in compliance with PED category I, II or III. 

Å Products of 25mm or 1" (inch) or smaller are Sound Engineering Practice (SEP). 

European Pressure Equipment Directive (PED) 

The Brooks Instrument (electric/electronic) equipment bearing the CE mark has been successfully tested to the regulations of the Electro Magnetic 

Compatibility (EMC directive 2014/30/EU). 

Special attention however is required when selecting the signal cable to be used with CE marked equipment. 

Quality of the signal cable, cable glands and connectors: 

Brooks Instrument supplies high quality cable(s) which meets the specifications for CE certification. 

If you provide your own signal cable you should use a cable which is overall completely screened with a 100% shield. 

ñDò or ñCircularò type connectors used should be shielded with a metal shield. If applicable, metal cable glands must be used providing cable screen clamping. 

The cable screen should be connected to the metal shell or gland and shielded at both ends over 360 Degrees. 

The shield should be terminated to an earth ground. 

Card Edge Connectors are standard non-metallic. The cables used must be screened with 100% shield to comply with CE certification. 

The shield should be terminated to an earth ground. 

For pin configuration : Please refer to the enclosed Instruction Manual. 

European Electromagnetic Compatibility (EMC) 
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Dear Customer, 

 
We recommend that you read this manual in its entirety as there have been some changes since previous 
versions. This will enable efficient and proper use of the Brooks Expert Support Tool software. Should you require 
any additional information concerning Brooks Expert Support Tool, please feel free to contact your local Brooks 
Sales and Service Office; see back cover for contact information, or visit us on the web at 
www.BrooksInstrument.com. We appreciate this opportunity to service your fluid measurement and control 
requirements, and trust that we will be able to provide you with further assistance in future. 

 
Yours sincerely, Brooks Instrument 

 
 

http://www.brooksinstrument.com/
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Chapter 1 Introduction 

1.1 Description 

The Brooksô Expert Support Tool is a Windows®-based application that 
provides expanded monitoring & control of the Brooksô digital thermal 
mass flow controller/meter, flow controller/meter, pressure controller and 
remote pressure transducer (RT), and pressure-based flow controller 
modes for servicing tasks that include setup, configuration, calibration, 
tuning, control, monitoring, and troubleshooting. For device 
troubleshooting information, refer also to the deviceôs Installation and 
Operations Manual. 

Use of some features requires a Pro software license which is 
obtainable on a subscription basis. Contact Brooks Instrument to obtain 
a license. See Table 2-4 through Table 2-9 for a list of which features 
require a license. 

Note that this user manual covers only the use of BEST with SLA Rev B 
(ñEnhancedò), PC1xx, VDM300, GF40, GF1xx, and GP200 devices. 
BEST also supports SLA Rev A (ñLegacyò) and Quantim B devices. 
Those products are covered by a separate BEST user manual for those 
products. 

 
Figure 1-1 BEST Main Screen 

Note that the Brooks Expert Support Tool is meant to be used as a 
startup and troubleshooting tool. It is not intended to be permanently 
connected to the device in your system/application. 

See Table 1-1 for all product models supported by BEST. 
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Table 1-1 Device Model Families Supported in BEST 

Model Code Device Type Description 

SLA58** MFC/MFM/PC Mass Flow Controller, Meter, Pressure 
Controller 

SLA78** MFC/MFM/PC Mass Flow Controller, Meter, Pressure 
Controller 

SLA79** MFC/MFM/PC Mass Flow Controller, Meter, Pressure 
Controller 

SLAMF** MFC/MFM Mass Flow Controller, Meter 

PC115 PC Pressure Controller (Upstream or 
Downstream)1 

PC125 PC Pressure Controller (Downstream) with Flow 
Meter1 

VDM300 MFC DI Water Vapor Delivery Module 

GF40 MFC Thermal Mass Flow Controller 

GF1xx MFC Thermal Mass Flow Controller2 

GP200 MFC Pressure-based Flow Controller 
1. DeviceNet Only 
2. F100, GF101, GF120, GF121, GF125, GF126, GF135 

 

1.2 How to Use This Manual 

It is recommended that you read the device Installation & Operations 
Manual (IOM) prior to reading this manual. Read this manual in its 
entirety before installing or using the Brooks Expert Support Tool. 

Note that the illustrations of screens from BEST are illustrative ï the 
exact appearance on your computer screen may vary slightly. Also, if 
software versions are shown on the illustrations, your versions may vary 
slightly. 

Note: For device troubleshooting information, refer to the deviceôs 
Installation and Operations Manual. 

1.3 Integrated Help 

This user manual (which is searchable) can be accessed directly from 
the software, on the About->User Manual menu item. see Section 5.2. 
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Chapter 2 Installation 

This section describes the system requirements, how to install the BEST 
software onto a personal computer (PC), and how to connect the PC to 
the device. 

2.1 Hardware Requirements 

The hardware requirements are specific to each Brooks device.  

Brooks devices will have one of two diagnostic port connections: 2.5 mm 
jack plug or Micro USB. See Table 2-1. 

Table 2-1 Connector Types 

Device Model 2.5mm Jack Plug Micro USB 

SLA X  

PC1x5 X  

VDM300  X 

GF40   X  

GF1xx   X  

GP200  X 

 

The device is connected from its diagnostics port to a computer via the 
computerôs serial port or USB port. Various cable/adapter combinations 
are available to connect a device to the PC.  

The following adapters and cables are typically examples required to 
connect a device with the 2.5mm jack plug diagnostic port to the 
computers standard serial port: 

Å RS232 to RS485 converter. 

Å Service port cable with 2.5-mm jack plug and 9-pin sub-D 
connector. 

 

 

 
Figure 2-1 RS232 to RS485 Converter, cable  
(2.5-mm jack plug to 9-pin sub-D conn.) 
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The following adapters and cables connect a device with the 2.5mm 
jack plug diagnostic port to the computerôs standard USB port: 

Å USB to RS485 converter. 

Å Service port cable with 2.5-mm jack plug and 9-pin sub-D 
connector. 

 

 
Figure 2-2 USB to RS485 Converter 

 

Other adapter combinations may be possible. 

This equipment may be purchased either along with the Brooks Expert 
Support Tool software or separately from Brooks Instrument. Contact 
the factory or your local representative for details. 

 

Table 2-2 Available Brooks Instrument Cable Kit Options 

Part Number Description 

778Z010ZZZ Basic Cable Kit 

A331710003 Cable Assembly 2.5mm 

214F027AAA USB-RS485 converter with DB-9 
female 

778Z012ZZZ RS485 Analog/Profibus® Cable Kit 
w/Power Supply 24 Vdc 

641Z117AAA Power Supply 24 Vdc with DB-15 
female 

778Z013ZZZ EtherCAT® Cable Kit w/Power 
Supply 24 Vdc 

124Z170AAA Cable, Power, EtherCAT to DB-15 
male 

778Z014ZZZ DeviceNetTM Cable Kit w/Power 
Supply 24 Vdc 

124Z171AAA Cable, Power, DeviceNet to DB-15 
male 
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The following tools and cables connect a deviceôs Micro USB diagnostic 
port the PCôs standard USB port: 

Å Standard USB to Micro USB cable 

 
Figure 2-3 Standard USB to Micro USB cable 

*NOTE: No ñlicense dongleò is required, but a software license is 
required for Pro features of BEST. 

For device label printing, a label printer is required. All printer models 
are supported ï the user is responsible for installing the printer 
manufacturerôs drivers as needed. 

2.2 System Requirements 

This section describes system and software requirements to use the 
Brooks Expert Support Tool application on a personal computer (PC). 

The Brooks Expert Support Tool application can be installed on a 
Windows PC with the following requirements: 

 

Table 2-3 System Requirements 

Component Minimum Requirements 

Operating System Microsoft Windows 10 
Microsoft Windows 8 ï BEST has not been formally 
tested with Windows 8 
Microsoft Windows 7 ï 32-bit/64-bit 

COM Port One dedicated serial port or  
USB port with USB to serial adapter, and  
RS232/RS485 adapter   

Software License Required for Pro Features (Calibration) 
See Table 2-4 to Table 2-9 for specifics 
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Table 2-4 Pro Features Requiring a License for SLA Rev B Products 

Feature 
Standard 

Version (No 
License) 

Pro Version 

(License) 

Connection ᾛ ᾛ 

Terminal Commands X ᾛ 

View Device Info ᾛ ᾛ 

Dump File ᾛ ᾛ 

Wake Up State ᾛ ᾛ 

Protocol Settings ᾛ ᾛ 

Get Firmware Revision ᾛ ᾛ 

Update Firmware X ᾛ 

Model Code Editing* X ᾛ 

Restrictor Selection X ᾛ 

Orifice Selection X ᾛ 

Meter Simulate MFC X ᾛ 

Reboot/Power Cycle ᾛ ᾛ 

Control Source/Valve Control/Set Point ᾛ ᾛ 

Graph/Basic Status/Meters ᾛ ᾛ 

Warning Status ᾛ ᾛ 

Alarm Status ᾛ ᾛ 

User Totalizer ᾛ ᾛ 

Data Logging ᾛ ᾛ 

Sensor Zero ᾛ ᾛ 

Active Gas Page ᾛ ᾛ 

Pressure Application Instance ᾛ ᾛ 

Tuning ᾛ ᾛ 

Flow Calibration (MFC, MFM, RT devices)* X ᾛ 

Pressure Calibration (PC devices) X ᾛ 

Graph Settings ᾛ ᾛ 

User Totalizer Settings ᾛ ᾛ 

Warning Settings ᾛ ᾛ 

Alarm Settings ᾛ ᾛ 

Top Label Printing ᾛ ᾛ 

Can Label Printing X ᾛ 

*Some restrictions exist for Biotech devices. 
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Table 2-5 Pro Features Requiring a License for PC115/125 Products 

Feature Standard 
Version 

(No 
License) 

Pro 

Version 
(License) 

Connection ᾛ ᾛ 

Terminal Commands X ᾛ 

Device Info ᾛ ᾛ 

Dump File X ᾛ 

Wake Up State ᾛ ᾛ 

Protocol Settings  ᾛ ᾛ 

Get Firmware Revision ᾛ ᾛ 

Reboot/Power Cycle ᾛ ᾛ 

Control Source/Valve Control/Set Point ᾛ ᾛ 

Graph/Basic Status/Meters ᾛ ᾛ 

Warning Status ᾛ ᾛ 

Alarm Status ᾛ ᾛ 

User Totalizer ᾛ ᾛ 

Data Logging ᾛ ᾛ 

Sensor Zero ᾛ ᾛ 

Active Gas Page ᾛ ᾛ 

Pressure Application Instance ᾛ ᾛ 

Tuning ᾛ ᾛ 

Graph Settings ᾛ ᾛ 

User Totalizer Settings ᾛ ᾛ 

Warning Settings ᾛ ᾛ 

Top Label Printing ᾛ ᾛ 

Alarm Settings ᾛ ᾛ 

Top Label Printing ᾛ ᾛ 
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Table 2-6 Pro Features Requiring a License for VDM300 Products 

Feature 
Standard Version 

(No License) 

Pro Version 

(License) 

Connection ᾛ ᾛ 

Terminal Commands X ᾛ 

Device Info ᾛ ᾛ 

Dump File ᾛ ᾛ 

Wake Up State ᾛ ᾛ 

Protocol Settings ᾛ ᾛ 

Get Firmware Revision ᾛ ᾛ 

Reboot/Power Cycle ᾛ ᾛ 

Control Source/Valve Control/Set Point ᾛ ᾛ 

Graph/Basic Status/Meters ᾛ ᾛ 

Warning/Alarm Status ᾛ ᾛ 

Alarm Status ᾛ ᾛ 

Data Logging ᾛ ᾛ 

Sensor Zero ᾛ ᾛ 

Tuning X ᾛ 

Graph Settings ᾛ ᾛ 

Warning Settings ᾛ ᾛ 

Alarm Settings ᾛ ᾛ 

Calculators ᾛ ᾛ 

Automated Dry-Down Operation ᾛ ᾛ 
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Table 2-7 Pro Features Requiring a License for GF40 Products 

Feature 
Standard 

Version (No 
License) 

Pro Version 

(License) 

Connection ᾛ ᾛ 

Terminal Commands X ᾛ 

Device Info ᾛ ᾛ 

Dump File ᾛ ᾛ 

Wake Up State ᾛ ᾛ 

Protocol Settings  ᾛ ᾛ 

Get Firmware Revision ᾛ ᾛ 

Model Code Editing X ᾛ 

Meter Simulate MFC X ᾛ 

Reboot/Power Cycle ᾛ ᾛ 

Control Source/Valve Control/Set Point ᾛ ᾛ 

Graph/Basic Status/Meters ᾛ ᾛ 

Alarm/Warning Status ᾛ ᾛ 

Alarm Status ᾛ ᾛ 

Data Logging ᾛ ᾛ 

Sensor Zero ᾛ ᾛ 

Active Gas Page ᾛ ᾛ 

Tuning ᾛ ᾛ 

Flow Calibration X ᾛ 

Device WARP X ᾛ 

Graph Settings ᾛ ᾛ 

Alarm/Warning Settings ᾛ ᾛ 

Top Label Printing ᾛ ᾛ 

Can Label Printing X ᾛ 
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Table 2-8 Pro Features Requiring a License for GP200 Products 

Feature Standard 

Version (No 

License) 

Pro Version 

(License) 

Connection ṉ ṉ 

Terminal Commands ṉ ṉ 

Device Info ṉ ṉ 

Dump File ṉ ṉ 

Wake Up State ṉ ṉ 

Protocol Settings ṉ ṉ 

Get Firmware Revision ṉ ṉ 

Update Firmware X X 

Reboot/Power Cycle ṉ ṉ 

Control Source/Valve Control/Setpoint ṉ ṉ 

Graph/Basic Status/Meters ṉ ṉ 

Warning Status ṉ ṉ 

Alarm Status ṉ ṉ 

User Totalizer ṉ ṉ 

Data Logging ṉ ṉ 

Sensor Zero ṉ ṉ 

Active Gas Page Creation ṉ ṉ 

Graph Settings ṉ ṉ 

User Totalizer Settings ṉ ṉ 

Warning Settings ṉ ṉ 

Alarm Settings ṉ ṉ 

Top Label Printing ṉ ṉ 

Device WARP X ṉ 

Can Label Printing X ṉ 
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Table 2-9 Pro Features Requiring a License for GF1xx Products 

Feature 
Standard 

Version (No 
License) 

Pro Version 

(License) 

Connection ᾛ ᾛ 

Terminal Commands X ᾛ 

Device Info ᾛ ᾛ 

Dump File X ᾛ 

Wake Up State ᾛ ᾛ 

Protocol Settings  ᾛ ᾛ 

Get Firmware Revision ᾛ ᾛ 

Model Code Editing X X 

Meter Simulate MFC X ᾛ 

Reboot/Power Cycle ᾛ ᾛ 

Control Source/Valve Control/Set Point ᾛ ᾛ 

Graph/Basic Status/Meters ᾛ ᾛ 

Alarm/Warning Status ᾛ ᾛ 

Alarm Status ᾛ ᾛ 

Data Logging ᾛ ᾛ 

Sensor Zero ᾛ ᾛ 

Active Gas Page ᾛ ᾛ 

Tuning ᾛ ᾛ 

Flow Calibration X ᾛ 

Device WARP X ᾛ 

Graph Settings ᾛ ᾛ 

Alarm/Warning Settings ᾛ ᾛ 

Top Label Printing ᾛ ᾛ 

Can Label Printing X ᾛ 

 
 

2.3 Installing the Brooks Expert Support Tool Application 

This section describes how to install the Brooks Expert Support Tool 
application onto a personal computer (PC). 

Uninstallation of existing versions of BEST prior to installation is not 
required, but recommended. see Section 2.5 for more details about 
uninstallation. 

To install the Brooks Expert Support Tool application, download the 
BEST installer file from the Products/Software section of the Brooks 
Instrument website (www.brooksinstrument.com). Once the installation 
file is downloaded, decompress if necessary. 

Before installing, open and read the Readme file for last-minute updates 
and helpful notes that may not be included in this user manual. 

Before starting the BEST installer, it is recommended to disconnect or 
power down any mass flow devices connected to the computerôs serial 
ports or USB ports. 

Run the setup.exe file - it is recommended to run this file as an 
administrator. Right click on the file and a pop-up menu appears. (See 
Figure 2-4). Click ñRun as administrator.ò 
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Figure 2-4 Running Setup.exe as an Admin 

Next, follow the installation instructions provided by the software. It is 
strongly recommended to install BEST and its components in the default 
folders provided by the installer. 

The installer will install BEST and its required software components, 
including versions of FloCom, FloComPlus and the FlocCom databases. 

For users who require a specific version of the FloCom database 
component, during the installation, the user will be presented with a 
software component selection menu (See Figure 2-5). Uncheck the item 
FloCom Databases to preserve the currently installed version and not 
install the version from the installer.  

*NOTE: BEST requires certain versions of FloCom, FloComPlus, and  
FloCom database be installed for maximum functionality. If you do not 
install the database version from the installer you must ensure that the 
desired version of FloCom database is installed separately from the 
BEST installer. 

Table 2-10 FloCom Recommended Versions Installed with BEST 5.10 

Program Required Version 

FloCom 4.16 

FloComPlus 1.41.03 

FloCom Database 20200813 
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Figure 2-5 Installer Software Component Menu  
(Your versions may vary) 

Virtual COM Port Driver: To use BEST with the VDM300 device it is 
necessary to install the virtual COM port (serial port/USB) driver. This 
driver is normally installed via the BEST installer. Make sure that the 
Virtual COM Port Driver check box is checked (see Figure 2-5).  

See also the ReadMe file for more information about the Virtual COM 
port driver. 

USB to Serial Port Driver: To use BEST with the USB to RS485 
adapter, this driver is needed. 

During installation, if it is installing a software component that already 
exists, the installer may present you with the options of Modify, Repair, 
or Remove, or similar: typically, choose repair. If it presents you with the 
options Complete or Custom, choose Complete. 

The installer will optionally create an item in the Brooks Instrument 
program group and a shortcut icon on the Windows desktop. 

Upon completion of installation, a software license must also be installed 
for access to Pro features of BEST. Contact Brooks Instrument to obtain 
a license. License installation instructions are covered in Section  5.1.2. 

2.4 License Installation 

To obtain a license, the user must contact Brooks Instrument to obtain a 
yearly license subscription. The user will receive a license key (a 
number), then enter it in the License Key text block (see Figure 2-6). 

*NOTE: After receiving your license key, store it in a secure location 
(backed up and secure from unauthorized use) for later retrieval. 
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Normally, the license installation process requires an Internet 
connection. A license can be installed without an Internet connection ï 
contact Brooks Instrument for details.  

To install a license, click on the menu Help->License->Install License. 
The window in Figure 2-6 will appear.  

 

Figure 2-6 License Installation Window 

Copy and paste your license key text into the License Key text box. 
Then click Install. The software will attempt to use an Internet 
connection to contact Brooks Instrument to verify the license. Then the 
license will be installed on the local computer. You will receive a 
message when it is finished. To view the installed license, click the 
menu item Help->License->Info. See also Section 5.1.1. 

 

Figure 2-7 License Information Window 
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2.5 Uninstalling the Brooks Expert Support Tool Application 

To uninstall BEST, go to the Windows Control Panel -> Programs and 
Features. Look for any items entitled ñBrooks Expert Support Toolò. 
Right click the item and select Uninstall. Follow the onscreen 
instructions. 

Repeat for any items with the title ñBrooks Expert Support Toolò. 

*NOTE: The uninstallation does not uninstall any of the auxiliary 
components such as FloCom or FloCom databases, installed with 
BEST. These do not necessarily need to be uninstalled, but to uninstall, 
repeat the above paragraph for the items ñFloComò, ñFcPlusò, etc. 

2.6 Connection Procedure 

To connect Brooks devices utilizing the 2.5mm jack plug diagnostics 
port to the computer: 

1. Connect the RS232 side of the RS232 to RS485 converter to a 
serial port on your computer. Ensure the ñRS485ò side is 
connected away from the computer. 

2. Alternatively, you may user a USB to RS485 in place of the 
RS232 to RS485 converter. Connect the converter to a USB 
port on your computer. Ensure the ñRS485ò side is connected 
away from the computer. 

3. Insert the 2.5-mm jack plug into the deviceôs diagnostics 
port (labeled ñDIAGò on the device, as shown in Figure 
2-9). 

4. Connect the desired power cable to the device and to the 
power source. Reference the device manual. 

5. Verify that the device is powered on and the MOD LED is 
solid green or flashing red. 

 

Figure 2-8 RS232 to RS485 Connection 
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For Brooks devices utilizing a Micro USB port, connect a standard USB 
to Micro USB cable between the computerôs USB port and the deviceôs 
Micro USB diagnostic port. 

 
Figure 2-9 Typical Diagnostics Port Connection (SLA Rev B Model shown) 

 
Figure 2-10 Typical Diagnostics Port Connection (Pc1xx Model shown) 
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Figure 2-11 Micro USB Diagnostic Port (VDM300 model shown) 

2.7 Disconnecting the PC from the Device 

When you are done using the Brooks Expert Support Tool, you should 
disconnect the computer from the device. 

To disconnect the computer from the deviceôs service port: 

1. Detach from the device using the software Connection Window. 

2. Exit from the Brooks Expert Support Tool software, optionally. 

3. Disconnect the cable between the computer and device. 
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Chapter 3 Basic Operations 

This section gives a general introduction to the basic operation of BEST, 
including starting BEST, the main screen, establishing communications 
with a device, viewing the main graph window, detaching from a device, 
and the menus. 

3.1 Main Screen 
 

To start BEST, select BEST from your Start menu, or double-click its 
application shortcut. The main window displays, with no devices 
connected. 

 
Figure 3-1 Main Screen with Device Connection Window 

The Title Bar shows the name and current version of the software. The 
title bar can also be used to select, move, and maximize the window, 
according to Windows conventions. 

The Menu Bar is where most functionality of BEST is accessed. BEST 
windows are opened from the menu bar. Menu items are typically 
accessed from left to right and top to bottom. 

The BEST desktop is where all opened BEST windows exist. This is 
similar to the Windows desktop, except that this desktop contains only 
BEST windows. See also Chapter 6. 

The Status Bar shows useful instructions and messages about the 
current status of the software and its processes. 

 

If the user is using dual monitors, the user may gain additional space for 
windows by dragging the side edge of main screen across to the 
additional monitor. 
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When the software first starts, it shows the device connection window in 
the center of the screen. To use most features of BEST, you must first 
ñattachò (or establish communication with) a device using the device 
connection window. see Section 10.1 for more details about the 
Connection Window. 

3.2 Attaching to a Device 

The first thing to do is to establish communications with (or ñattach" to) a 
device. 

When BEST software starts, no devices are attached. Devices are 
attached via the device connection window. For convenience, the 
software opens the device connection window for you upon startup. 

First, in the Device Connection/COM Port drop-down list (See Figure 
3-2), select the COM Port you are using to connect to your device.  

Next, select the desired Baud rate from the Device Connection->Baud 
rate drop-down list. Most users will choose Optimize, which will 
automatically select the fastest baud rate that successfully 
communicates with the device. if you have trouble attaching to a device, 
you can try a lower baud rate to troubleshoot. Your selected port and 
baud rate selections will be retained by BEST for your convenience. 

Click the Next > 1 Device button to find the connected MAC address. 
After a few moments, if a device is located, its MAC ID (or ñaddressò) is 
listed in the Mac ID drop-down list. 

Once a deviceôs MAC ID is located, click on the Attach button. After a 
few moments, if it is attached, a row appears in the connected devices 
box, as shown in Figure 3-2. 

 
Figure 3-2 Device Connection Window, Device Attached 

Once the device is attached, close the Device Connection window. 

For some device types, a window will then pop up asking if you want to 

place the device in the executing state. 
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Figure 3-3 Executing Mode Window 

If you need to control the deviceôs setpoint or valve with BEST, click 

Yes. 

Once the device is attached, close the Device Connection window. 

Likewise, when detaching from a device, it may ask you if you want to 

place the device in the idle state or SafeState. 

 

Figure 3-4 Idle Mode Window 

See also Section 10.1 for more details about device connections. 

3.3 Main Graph 
 

Once a device is attached, you can run the main graph to monitor the 
behavior of the device. Click on the green button in the upper left corner 
of the Devices Connected block. The main graph window will open, then 
Click Start. 
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Figure 3-5 Graph Window 

see Section 8.4 for more details about the graph window. 

3.4 Closing the Session with the Device and Exiting BEST 
 

To close the communication session with a device and exit the software, 
open the File menu and choose Exit, or click the windowôs close button 
(the X in the upper right corner). Exiting the software automatically 
closes all communications with the device. 

Alternatively, the user may close the communications with (or ñdetachò 
from) the device, by opening the Device Comm->Connection menu. 
Then click Detach. The user may attach to another device, if desired. 

3.5 Brooks Expert Support Tool Conventions 
 

The Brooks Expert Support Tool was designed to remain consistent with 
regard to how the user interacts with the application across all functions 
and features. It is also generally consistent with Windows user interface 
conventions. 

The following text field conventions apply throughout the software: 

¶ Text fields with a gray background display a read-only 

value (such as the Current Position (%) in Figure 3-6). 

¶ Text fields with a white background are editable 

(such as Set Point Position (%) in Figure 3-6). 
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¶ Usually, editable text fields update the software or device 

either when the user clicks the Enter button, when the 

focus moves to another field by using the Tab key or 

mouse, or when a separate apply button is clicked (see 

each section in the manual for specific instructions). 

¶ If a text box contains ñNaNò or ñn. def.ò it means ñNot a 

Numberò, not defined, or invalid calculation result. 

Many windows also require numeric input from the user. This type of 
window is also called a ñformò. For numeric input, forms often feature 
numeric up/down controls. See Figure 3-6 for an example of a numeric 
up/down control (circled). 

 
Figure 3-6 Example Numeric Up/Down Control 

Up/down controls help prevent invalid numeric data entry. Click the up 
arrow to increment the numeric value, or the down arrow to decrement. 
Up/down controls also have maximum and minimum values. You may 
also type in a number directly, but it wonôt allow non-numeric entry. Also, 
in some cases, it wonôt accept the thousands separator character (for 
example, ñ,ò in English culture). In most forms, you may also click enter 
to accept the entered value, or move the focus off the control to another 
control on the form. 

Data Entry and International Locales: While BEST doesnôt translate 
all words from the English language, BEST supports various number 
and date formats for data entry and display, according to the userôs 
computer settings for that region (see Control Panel->Region and 
Language on your computer). BEST uses the userôs Windows settings 
for region and locale for most numeric data, except where noted in this 
manual. For example, when entering a decimal number in English a 
user might type 1.234 into a text box, but for German culture, one would 
enter 1,234 because in that culture the comma is the decimal separator. 

*NOTE: In some BEST windows you must always enter English 
formatted numbers (because that is what the device expects). For 
example, in the terminal window, you must use English decimal number 
formats because the commands that a device accepts require English. 
In those types of windows, a statement will be present on the form as a 
reminder. 

For most windows in BEST, for data entry, you must use the format of 
your region, except where noted. Likewise, most windows will display 
numbers in the format of your region, except where noted. 

The sample illustrations in this manual are shown using the English 
region formatting. 
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3.6 Menu Bar 
 

The Menu Bar (see Figure 3-1) is where most of the functionality of 
BEST is accessed. Most BEST windows are opened from the menu bar, 
and then those windows will exist on the BEST Desktop. Menu items are 
typically accessed from left to right and top to bottom. 

Note that this manual shows all menu items. Certain menus may not 
appear if the features of those menus are not supported by the currently 
selected device. 

Subsequent chapters of this manual describe each of the menus in 
detail. 
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Chapter 4 File Menu 

The File Menu Item contains a place to exit the program. See Figure 
4-1. (You may also exit the program via the ñXò in the upper right of the 
title bar, according to Windows convention). 

 
Figure 4-1 File->Exit Menu 
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Chapter 5 Help Menu Item 

The Help Menu Item is where information about the BEST software can 
be accessed, including the current version of BEST, licensing options, 
and user help. A device connection is not required to access these menu 
items. 

 
Figure 5-1 Help Menu 

5.1 About Window 
 

The About-> About Menu Item is where information about the current 
version of BEST and its software components can be viewed. 
Information provided includes the current version of BEST and it 
software components. (The current version of BEST is also always 
visible in the main windowôs title bar.) 

 
Figure 5-2 About Window  
(Your versions may vary) 

 



 Installation and Operation Manual 

X-SW-BEST-RevB 

Part Number: 541B197AAG 

March, 2021 

 

Brooks® Expert Support Tool 

 

5-2  
 

 
 

5-1 

5.1.1 License Info Window 

The License Info Menu Item is where information about installed 
licenses for the current version of BEST can be viewed (but not 
updated). The user may also set options about when to be reminded of 
license expiration. 

 
Figure 5-3 License Information Window  
(Your data may vary) 

5.1.2 Install License Window 

The Install License Menu Item is where licenses may be installed (and 
uninstalled). The user must contact Brooks Instrument to obtain an 
annual license subscription, if desired. The user will receive a license 
key (a number), then enter it in the License Key text block. 

*NOTE: After receiving your license key, store it in a safe location 
(backed up and secure from unauthorized use) for later retrieval. 

Normally, the license installation process requires an Internet 
connection. A license can be installed without an Internet connection ï 
contact Brooks Instrument for details. 
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Figure 5-4 License Install Window 

 

5.1.3 EULA Window 

The EULA is where the user may view the End User License Agreement 
(EULA). 

 

5.2 User Manual Menu 
 

This BEST user manual (which is searchable) can be accessible directly 
from the software under the Help->User Manual menu. A PDF file reader 
(such as Adobe Reader or Microsoft Edge) must be installed on the 
computer to read this file. 

 

5.3 ReadMe Menu 
 

The user may view last-minute updates (not included in this manual) as 
well as technical and useful troubleshooting information from this menu. 
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Chapter 6 Window Menu 

The Window Menu Item is where BEST windows can be accessed and 
controlled. 

BEST windows exist on the BEST desktop (see Figure 3-1). This is 
similar to the Windows desktop, except that the BEST desktop contains 
only BEST windows. 

BEST windows are sized and closed in a similar way as in the Windows 
operating system. Most BEST windows can be sized, minimized, 
maximized, and restored. Some BEST windows have minimum and/or 
maximum sizes. Multiple windows may be opened with some 
exceptions. Some windows, such as calibration windows, when they are 
open, do not allow access to other windows until they are first closed. 
(These are called ñmodalò windows). A modal window cannot be 
minimized or maximized, but may be resized by dragging the sizing 
handle in the lower right corner of the window (if the windows is not 
maximized). 

Note also that the title bar of each BEST window shows the serial 
number of the device associated with that window. 

 

Figure 6-1 Window Menu 

If any windows are open in the BEST desktop, they will be listed in the 
Window menu under the Arrange item (See Figure 6-1). Clicking on one 
of those items will activate that window. 

The Close All Window menu item closes all windows (for all devices). 

The Cascade Window menu item, arranges all open windows in a 
ñcascadeò arrangement from the upper left corner of the windows. See 
Figure 6-2. 
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Figure 6-2 Cascaded Window Layout 

 

Figure 6-3 Tiled Window Layout 

Tile will arrange all open windows in a ñtiledò arrangement. See Figure 
6-3. 

Minimize All minimizes all windows to an icon representation. See 
Figure 6-4. 

NOTE: If a modal window is minimized, it will disappear into an icon at 
the bottom of the screen. To restore it, click on the icon. 
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Figure 6-4 Minimized Windows 
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Chapter 7 Settings 

The Settings Menu Item is where BEST software options can be 
changed to the userôs preferences. These are software options, not 
device options. Most of the features in this menu do not require a device 
connection. Menu items shown depends on device type. 

 
Figure 7-1 Settings Menu 

7.1 Graph Options 

The Graph Options is where the user can select options and 
preferences for the operation of the main graph window. Here the user 
can select preferences such as the data units, scaling, number of 
decimal places, and graph legend options. See Figure 7-2 for the Graph 
Options window. 

Device 

 

Figure 7-2 Graph Options Window 

For each graph parameter, the user can choose which parameters to 
show on the graph, legend, and meters panel (see Section 8.4 for more 
information on the meters panel of the main graph window). 
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The user can also choose to allow the software to determine which 
device parameters to show automatically by choosing to select Auto 
Show Default Parameters, in which case the software will show only 
the parameters relevant for the device type (for example, an MFC 
device will not show pressure or pressure setpoint). If Auto Show 
Default Parameters is checked, the individual parametersô Show on 
Graph check boxes will be disabled ï if it is unchecked they will be 
enabled. For most usages, leave Auto Show Default Parameters 
checked. 

*NOTE: If you need a higher data sample rate on the main graph, such 
as with response tuning, uncheck the Auto Show Default Parameters 
check box and select only the parameters you need to view. Unchecking 
the Valve Position parameter can yield significant increases in sample 
rate. 

For each parameter, the user can choose ñdevice unitsò in which case 
the units stored in the device are automatically chosen for display. 

The graph Y axis scaling for both the left side Y axis and the right side Y 
axis can adjusted by the user. The left side axis is for flow, flow setpoint, 
pressure, and pressure setpoint. The right side axis is for valve position, 
valve current, temperature, and density.  

The Num Dec Places block sets the number of decimal places 
displayed for numeric data across the software. 

Valve current is for VDM300 devices only. 

*NOTE: For some parameters, changing graph settings while the graph 
is running may require the graph to be closed and re-opened for the 
changes to take effect. 

7.2 Reset All User Options 

Reset All User Options is where the user can reset all BEST software 
user settings to their factory default settings. Use with caution.  

 

7.3 Data Logging Options 

The Data Logging Options Menu Item is where the user can set 
preferences as to whether data from the main graph window is to be 
saved to file as it monitors. Check the check box Save Data To Log to save 
data to file. Files can be saved in either text or csv format. The file name will 
be created automatically. The folder is listed in the Data Log File Path text 
box. The user can also conveniently open saved files from the path by 
clicking a single button, the Open File button. See Figure 7-3 for the Data 
logging options window. 

The data logging status (on or off) is shown at the bottom of the main 

graph window. 

The user may also have some control over the sample rate (of both the 

graphical display and the recorded data). Under the units drop-down, 

select Maximum to obtain the maximum sample rate on your system. 

Otherwise, select SamplesPerSecond or SecondsPerSample, then set the 

Target rate. The target rate is not a guaranteed rate, nor is the rate 

guaranteed to be precise. 
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Figure 7-3 Data Logging Options 

7.4 User Totalizer Options 

For devices that support a totalizer, the User Totalizer Options Menu 
Item is where the user can set preferences for the user totalizer for 
devices that support a totalizer. (NOTE: the user totalizer is different than 
the deviceôs hardware totalizer. See Section 8.3 for details on the 
hardware and user totalizers). The user can set preferences as to how 
often to update the user totalizer window and can reset the user totalizer. 
See Figure 7-4. The user totalizer units are always the same as the 
deviceôs setting for totalizer units. 

A device must be attached to see and use this window. 

 
Figure 7-4 User Totalizer Options 
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7.4.1 User Totalizer Options 

 

For SLA devices with EthernetIP digital I/O option, a different 
totalizer window is used. 

 
 

 
Figure 7-5 EthernetIP Totalizer 

 

For the fmTotalizer, the user may set the total value to a specific 
value. Change the value in ñNew Flow Totalò then click Set 
Valueò. The user may not change the fmFlowHours. 

The user may also change the mode for the fmCustFlowTotalizer. 
To stop the totalizer, change the New Mode to Stop, then click 
Set Mode. To reset the totalizer, change the New Mode to Reset, 
then click Set Mode. To restart the totalizer, change the New 
Mode to Run, then click Set Mode.
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Chapter 8 Monitoring Menu 

The Monitoring menu gives the user the ability to monitor various 
aspects of the device. Each of the windows accessible through the 
Monitoring menu, when opened, shows a live status of various 
parameters of the device. This includes alarms, warnings, flow, 
pressure, control, and other status parameters. 

 
Figure 8-1 Monitoring Menu  
(not all devices support all menus) 

Except for the graph window (Section 8.4), and VDM300 DryDown 
Reports (section 8.9), these windows are monitoring as long as they 
are open. These windows update typically at about once per second. 
These windows are read-only windows and can access and display 
these parameters whether the device is in internal (digital) or external 
(analog) control mode. 

Most Monitoring menu windows can be resized by using the mouse to 
grab an edge or corner of the window and dragging. 

8.1 Warning Status 

The Warning Status Window shows detailed warning states for 
supported devices interfaces/protocols. For some device types, the 
warning status is integrated with the alarm status window. The exact 
warnings shown may vary depending on the device type. The warning 
window for a flow controller is shown in Figure 8-2. 






















































































































































































































































